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Preface1

About this Collection

Word Processing Essentials

Word Processing Essentials is a collection of modules to teach or refresh skills for Microsoft Word. The
intended audience is anyone needing to create a simple term or research paper for a high school or college
course.

The collection was designed by Kenneth Leroy Busbee; however the modules in the collection were
authored by students enrolled in a BCIS1405 � Business Computer Applications course at the Community
College of Qatar (CCQ) during the Fall 2010 term.

Collection Contents

The collection has a preface module followed by �ve sections with topics ordered in a sequence that follows
the production of a term/research paper. The sections are:

• Preliminaries
• Typing
• Improving
• Printing
• Appendix

Professional Encouragement

This project provided the students with the following supplemental experiences which all college graduates
should encounter:

1. Student Service Learning � Many of the students at CCQ will start their college education in a
phase of English as a Second Language (ESL). As students progress, they will have writing assignments
that include a simple research papers. Faculty teaching ESL courses need appropriate materials to
help students use word processing application software to complete their assignments. The need being
established, having more mature students serve other students by preparing educational materials is
an excellent service project.

2. Team Work � All college graduates will work in many teams during their professional careers. Cre-
ating this collection as a team, helped students see the importance that collaborative e�orts play in
their futures.

3. Open Educational Resources (OER) � Electronic communication, speci�cally the internet, means
we live in an ever shrinking world. Part of that world is freely sharing their e�orts with others. Exposing
students to one of the world's leading OER repositories, Connexions, enhances their understanding of
this important part of education, research and publishing.

1This content is available online at <http://cnx.org/content/m36055/1.5/>.
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4. Writing Across the Curriculum � The concept is dated, but still important. Using their English
writing skills, students now see the importance of clear written communication. Their e�orts are not
being graded by an English teacher, but by all who will read their published materials.

College professors and others considering a group project involving the creation of OER materials are en-
couraged you to become a Connexions author of at least a dozen modules and one collection. Consider the
following links:

• Understanding the Vision of Connexions � Link: http://cnx.org/content/col11187/latest/2

• Authoring Connexions Modules using Microsoft Word Documents - Link:
http://cnx.org/content/col11154/latest/3

• Ideas and Tools for Improving Connexions Modules and Collections � Link:
http://cnx.org/content/col11184/latest/4

About Connexions

Connexions Modular Content

Connexions http://cnx.org5 is an online, open access educational resource dedicated to providing high
quality learning materials free online, free in printable PDF format, free as an EPUB download, and at
low cost in bound volumes through print-on-demand publishing. This collection is one of many collections
available to Connexions users. Each collection is composed of a number of re-usable learning modules
written in the Connexions XML markup language. Each module may also be re-used (or 're-purposed') as
part of other collections and may be used outside of Connexions.

Re-use and Customization

The Creative Commons (CC) Attribution license6 applies to all Connexions modules. Under this license,
any Connexions module may be used or modi�ed for any purpose as long as proper attribution to the
original author(s) is maintained. Connexions' authoring tools make re-use (or re-purposing) easy. Therefore,
instructors anywhere are permitted to create customized versions of this collection/textbook by editing
modules, deleting unneeded modules, and adding their own supplementary modules. Connexions' authoring
tools keep track of these changes and maintain the CC license's required attribution to the original authors.
This process creates a new collection that can be viewed online, downloaded as an EPUB, downloaded as a
single PDF �le, or ordered in any quantity by instructors and students as a low-cost printed textbook.

Read the book online, download the EPUB, print the PDF, or buy a copy of
the book.

To browse this collection online, visit the collection home page. You will then have four options:

1. You may view the collection modules on-line by clicking on the �Start �� link, which takes you to the
�rst module in the collection. You can then navigate through the subsequent modules by using their
�Next �� and �Previous �� links to move forward and backward in the collection. You can jump to
any module in the collection by clicking on that module's title in the �Collection Contents� box on the
left side of the window. If these contents are hidden, make them visible by clicking on �[show table of
contents]�.

2Understanding the Vision of Connexions <http://cnx.org/content/col11187/latest/>
3Authoring Connexions Modules using Microsoft Word Documents <http://cnx.org/content/col11154/latest/>
4Ideas and Tools for Improving Connexions Modules and Collections <http://cnx.org/content/col11184/latest/>
5http://cnx.org/
6http://creativecommons.org/licenses/by/3.0/
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2. You may obtain a PDF of the entire textbook to print or view o�ine by clicking on the �Download�
menu item.

3. You may download the entire textbook as an EPUB by clicking on the �Download� menu item.
4. You may order a bound copy of the collection (for a reasonable printing and shipping fee) by clicking

on the �Order printed collection� button.



4



Chapter 1

Preliminaries

1.1 Files Management1

1.1.1 Usb Drive:

Usb drive can be used for storing �le and folders, it can be used for backing up �les, and it is Easy to share
and travel with.

• You can �nd the USB Drive in my computer in start.
• You will �nd it under Devices with removable storage.
• You can rename the USB Drive by clicking the right side of the mouse.

1This content is available online at <http://cnx.org/content/m36246/1.1/>.
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6 CHAPTER 1. PRELIMINARIES

Figure 1.1

1.1.2 To create a folder in the USB Drive:

Folders can be created in Documents and in the Desktop, with creating folders you can create a folder within
the folder that's called �Subfolders�.

• Start my computer.
• Double-Click on the removable disk
• Right click on the empty space �nd the word �New� � �nd the word �Folder�.
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Figure 1.2

1.1.3 To save �lls in the folder USB Drive:

Saving �les is very easy, you can save �les anywhere in the computer, you can rename the �le; change the
saving location of the �le, and save it in a Di�erent type.

Press the �o�ce button�.
Click on �Save as�.
Type the �le name.
Change the location of the �le anywhere on the computer
Click �Save�.
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Figure 1.3

1.2 Undo Command2

The undo command is used to quickly undo any recent key strokes. It is used when mistakes occur and
the user wishes to undo it. For example when a user was typing some text then suddenly it disappears
through pressing the wrong key, the easiest way to retrieve the data is through the undo command. The
undo command is located next to the save button.

2This content is available online at <http://cnx.org/content/m36244/1.1/>.



9

Figure 1.4

As shown in the image above you will have to press the undo command to commence undoing.
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Chapter 2

Typing

2.1 Paragraph Concept1

2.1.1 Word Wrap

Word wrap is the feature of breaking lines between and not within words, except when a single word is
longer than a line. So, when your line is full of text, the word processor automatically jumps to the next line.
Sometime, the text may wrap in an unwanted location. To make the reading easier, you need to proofread
word wrapping location and insert special characters. Two things to be concerned with are how to control
word wrapping with nonbreaking hyphens and nonbreaking spaces?

• Insert Nonbreaking Hyphens

If there is a word with hyphen at the end of a line, the �rst word and the hyphen may appear on the �rst
line, and the second word will be in the next line. So, to keep word with hyphen together, replace the regular
hyphen with a nonbreaking hyphen. A nonbreaking hyphen prevents the word with hyphen from becoming
separated at the hyphen. To insert a nonbreaking hyphen, press Ctrl+Shift+Hyphen.

• Insert Nonbreaking Spaces

Sometimes text willwrap to the next line if a word does not �t at the end of the line, so some words should
be kept together for improved readability. To prevent words from separating due to the word-wrap feature,
you can insert a nonbreaking space. To insert a nonbreaking space, press Ctrl+Shift+Spacebar between the
two words that you want to keep together.

1This content is available online at <http://cnx.org/content/m36218/1.1/>.
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12 CHAPTER 2. TYPING

Figure 2.1

2.1.2 Show/Hide spaces, return, and tabs

I cannot tell you how helpful using this feature can be. If you get used to working in Word with this feature
turned ON, you'll keep yourself out of so much trouble! As you type text, Word inserts nonprinting marks
or symbols. To see these symbols click the Home tab, in the Paragraph group, click Show/Hide button that
look like a reversed �p�. When you click it you will see the di�erent characters that show you there are
spaces, returns, and tabs on your text.
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Figure 2.2

2.2 Insert versus Overtype2

2.2.1 Insert

Insert means that you add text to the current text without replacing any single letter. For example, the
original sentence is �John is a good person�; if you insert �very� between �a� and �good�, the sentence will be
�John is a very good person�.

To insert a text:
Step 1 - Move the insertion point to the place you want to insert the text.
Step 2 - Type the text you want.

2.2.2 Overtype

Overtype means that you replace the current text with another text using the `Insert' button on the keyboard.
For example, the original sentence is �John is a very good person� and you want to replace �good� with �nice�.

2This content is available online at <http://cnx.org/content/m36262/1.1/>.
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If you put the insertion point before �good� and type �nice�, the sentence will be �John is a very nice person�
not �John is a very nice good person�.

To overtype a text:
Step 1 - Be sure to activate the `Overtype option'. To do that , follow the instructions:

Figure 2.3

Step 2 - To overtype the text, move the insertion point to the place you want to replace the text (before
the text); click the insert button (toggles from insert mode to overtype mode).
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Figure 2.4

Step 3 - Type the new text that will overtype the existing text. Hit the insert key to toggle o� the
overtype and return to the insert mode.

2.3 Auto Correct and Auto Text3

2.3.1 AutoCorrect

Many people make mistakes while they are typing in the word. You will notice while you are typing your
misspelled words will automatically be corrected. Here are the steps to turn on the AutoCorrect.

1- Click on start button as shown, and then press word option.
2- Choose Proo�ng.
3- When you click on proo�ng click on AutoCorrect option.
4- At the last step here you can replace the incorrect word with the correct one you choose.

3This content is available online at <http://cnx.org/content/m36292/1.1/>.
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Figure 2.5

2.3.2 AutoText

Auto text is one way to complete your un�nished words in the word document, while are you typing specially
dates, time, and years you will notice that there is something popping to you like in the picture below as
shown to you. You can con�rm that just by pressing ENTER.
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Figure 2.6

2.4 Spelling and Grammar Checker4

2.4.1 Spelling and Grammar Checker

Many students, especially ESL students, hope to write an academic essay, paper, or any academic writing
that is free of spelling or grammar mistakes. Sometimes when we revise our work, we might miss or cannot
recognize some of those mistakes, and for that reason, Microsoft O�ce Word has provided the world an
awesome feature called Spelling and Grammar Checker. Spelling and Grammar Checker helps you avoid
many common spelling and grammar errors in your word documents, and at the same time you may correct
some of them.

2.4.2 Types of Errors

There are three di�erent wavy underline colors that have three di�erent meanings: green, red, and blue; the
green wavy underline indicates grammatical error(s), the red wavy underline refers to spelling error(s), and

4This content is available online at <http://cnx.org/content/m36217/1.2/>.
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the blue wavy underline refers to contextual error(s).

Figure 2.7

2.4.3 Auto Corrections

Microsoft O�ce Word has a feature that corrects some spelling errors automatically; for example, if you type
"teh" instead of "the", the word "teh" will be adjusted automatically to "the". However, the application
cannot correct or �nd all grammar mistakes, so you have to review your document thoroughly before
printing the �nal draft, and make sure that your document does not have any spelling, grammatical, or
contextual errors.

There are many methods to identify misspelled words or questionable grammar in your document: you
may print your document and give it to someone else to correct it using a marker, or you may read your
document aloud that helps you �nd some mistakes.

2.4.4 Using Spelling and Grammar Checker

To start Spelling and Grammar Checker, do the following steps:
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Figure 2.8

Then, choose the appropriate options. Once you �nish, click the X button on the right top corner of the
Spelling and Grammar dialog box to close the dialog box.
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Chapter 3

Improving

3.1 Selecting Text and Applying E�ects1

3.1.1 Selecting Text

If you want to select a text you have to:-

• Move insertion point to the word that you want to select
• left click in the mouse and select the wanted text

1This content is available online at <http://cnx.org/content/m36220/1.1/>.
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22 CHAPTER 3. IMPROVING

Figure 3.1

3.1.2 Applying E�ects

If you want to apply e�ect in your text:-

• From the font box which is placed in home tab you can apply e�ects in your text such as, font, size,
bold, underlined, italic . . .

• You have to select the text, and then press the icon that you desire.
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Figure 3.2

The explanations for these numbers are:-

1. Bold: to make your type apper like this.
2. Italic: to make your type face curve or (bend) to the right like this.
3. Underline: to make a line below your text Like this.
4. Strikethrough: to cross the text or make a line at the middle of the text.
5. Highlight color: to highlight a text.
6. Font color: to change the font color.
7. Font size: to change the text size.
8. Font: to change the font hand writing or style.

3.2 Styles2

All formatting in Microsoft Word is controlled by styles. A style is a set of formatting instructions. Word
applies the formatting instructions when you apply a style. Microsoft Word comes with dozens of built-in
styles.

2This content is available online at <http://cnx.org/content/m36247/1.1/>.
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Here are the steps of applying a style:
Step 1: Select the text.

Figure 3.3

Step 2: Apply the style: using the mouse.
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Figure 3.4

The results when choosing Heading 1:
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Figure 3.5

3.3 Using the Thesaurus3

What is a Thesaurus: A thesaurus is a reference work4 that lists words grouped together according to
similarity of meaning (containing synonyms5 and sometimes antonyms6 ), in contrast to a dictionary7 ,
which contains de�nitions8 and pronunciations9 .

3This content is available online at <http://cnx.org/content/m36213/1.2/>.
4http://en.wikipedia.org/wiki/Reference_work
5http://en.wikipedia.org/wiki/Synonyms
6http://en.wikipedia.org/wiki/Antonyms
7http://en.wikipedia.org/wiki/Dictionary
8http://en.wikipedia.org/wiki/De�nitions
9http://en.wikipedia.org/wiki/Pronunciations
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Figure 3.6

Here are the �rst basic steps on how to use the thesaurus.
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Figure 3.7

Here its explaining on when you have a paragraph written instead of typing the word in the search bar,
you can just click on the word you want to change.



Chapter 4

Printing

4.1 Title Page1

Most research papers have a title page (sometimes called a cover page). The slide below shows simple
instructions to make a title page.

1This content is available online at <http://cnx.org/content/m36281/1.1/>.
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30 CHAPTER 4. PRINTING

Figure 4.1

4.2 Headers and Footers2

Header and Footer are to insert whatever you need (such as page numbers, title, date. . .Etc.) into the
head (top) and the foot (bottom) of each page. However, the main purpose for the header and footer is to
add various scripts to track the access to the blog (such as Google. . .Etc.).

To create a header or a footer:

(1) Click the Insert tab.
(2) Click on the Header/Footer pop-down menu.

2This content is available online at <http://cnx.org/content/m36219/1.1/>.
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Figure 4.2

After you insert the header/footer, type in header or footer whatever you like. . .
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Figure 4.3

(1) You can insert page numbers as it shown in the picture above by choosing the design you like.
(2) Also, you can change the height of the Header/footer from the Position group as it shown in the

picture above.
(3) After �nishing editing the header/footer, to exit click the (" Close Header and Footer", the red X

next to the Position group).

4.3 Citations with Footnotes or Endnotes3

Footnotes and endnotes make it easy to give credit to your sources or to add explanatory material. A
footnote appears at the end of the page, and the endnote appears at the end of the document. Footnotes
and endnotes are also used for additional information about a topic.

To insert footnote or endnote do the following as shown in �gure below:

1. Place the pointer where you want to insert the reference note.
2. Go to the references tab.
3. In the Footnotes group, click Insert Footnote or Insert Endnote.
4. Type your text, and click back to the text.

3This content is available online at <http://cnx.org/content/m36291/1.1/>.
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Figure 4.4

Automatically, Word places footnotes at the end of each page and endnotes at the end of the document.
Footnotes and endnotes are both separated from the body text by a short horizontal line. Both footnotes

and endnotes contain a note reference mark in the body text to indicate that additional information as shown
in �gures below. The footnote uses sequenced numerals (1, 2 . . .) and the endnote uses sequenced Roman
numerals (i, ii...). If add or delete notes, numbers automatically modi�ed.
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Figure 4.5
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Figure 4.6

Note text can be formatted as any other text. You can change its color, size, style, etc. You can easily
modify your notes simply by clicking inside the note and edit it. To delete note select its note reference
number in the text and press Delete.

Also you can modify it by clicking the Footnote and Endnote Dialog box launcher. Use the dialog box
launcher (a little box with an arrow) at the lower-right corner of the Footnotes group of the References tab.
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Figure 4.7

To convert the footnote to endnote or opposite, click on convert in the Footnote and Endnote Dialog box
launcher.
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Figure 4.8

After converting:
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Figure 4.9

4.4 Citations In-Line with Bibliography4

A bibliography is a list of works cited by an auther and should be included with the document when
published. Select either Bibliography or work cited from the list of Bilt-In Bibliographies. After you add
the sources using the Insert Citations feature, you click Bibliography in the Citations & Bibliography
group on the References tab, and then click Insert Bibliography. The insert Bibliography selection at
the bottom will work the same way it just won't format the bibliography like the Bilt-In selections.

4This content is available online at <http://cnx.org/content/m36245/1.1/>.
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Figure 4.10

4.5 Print Preview and Printing5

In the Print Preview, you can see what your document looks like before printing. It helps you to make your
paper looks perfect and organized which saves more papers .

In particular, if a part of your document is in the area in which the printer cannot actually print, the
Print Layout view may show your text anyway, but Print Preview probably will not.

Students must print preview their documents before printing to make sure that the document looks
perfect and to avoid wasting papers.

To start Print Preview, do the following steps.

5This content is available online at <http://cnx.org/content/m36215/1.1/>.
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Figure 4.11

This is how the Print Preview mode looks like.
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Figure 4.12
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Chapter 5

Appendix

5.1 Show Hide File Extensions1

By default, �le extensions for known �le types are hidden in Windows operating systems. However, you
can change this setting so that �le extensions are shown for all �le types. Being able to see �le extensions
can be very helpful for students taking computer courses because those course instructions often refer to �le
extensions.

All Windows operating systems navigate you to the �Folder Options� menu, then have you select the
�View� tab. Indeed the box is identical in Windows XP, Windows Vista and Windows 7.

1This content is available online at <http://cnx.org/content/m18100/1.6/>.
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Figure 5.1

The check in the box acts like a toggle switch. With a check present, it will hide known �le types.
Without the check present, it will show all �le types. Click on the box to make the check appear [hide �le
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extensions] or disappear [show �le extensions] and then select �OK�.
Instructions for navigating to the �Folder Options� for various Windows operating systems along with an

Internet link for additional help are provided below.

5.1.1 Windows XP

With the Windows Explorer open, slect the �Tools� tab and then �Folder Options�.
Link for additional help: http://www.�leinfo.net/help/windows-show-extensions.html2 or

http://dotwhat.net/page/displayextensions/3

5.1.2 Windows Vista

Select the �Start� button, then �Control Panel�, then �Appearance and Personalization� and then �Folder
Options�.

Link for additional help: http://windows.microsoft.com/en-us/windows-vista/Show-or-hide-�le-name-
extensions4

5.1.3 Windows 7

Select the �Start� button, then �Control Panel� and then �Folder Options�.
Link for additional help: http://maximumpcguides.com/windows-7/hide-�le-extensions/5

2http://www.�leinfo.net/help/windows-show-extensions.html
3http://dotwhat.net/page/displayextensions/
4http://windows.microsoft.com/en-us/windows-vista/Show-or-hide-�le-name-extensions
5http://maximumpcguides.com/windows-7/hide-�le-extensions/
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5.2 Using the Longman Dictionary6

5.2.1 Introduction

Figure 5.2

5.2.2 Key to the Dictionary

You will �nd below some simple explanations that would help you comprehend the major elements of the
Longman dictionary.

6This content is available online at <http://cnx.org/content/m36288/1.1/>.
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Figure 5.3
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5.2.3 Searching for a Word

The key to search for a word is the upper left/right smaller font words which represents a guide for the
search as shown below.

Figure 5.4

5.2.4 Phonetics & Detailed De�nitions

Figure 5.5
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Index of Keywords and Terms

Keywords are listed by the section with that keyword (page numbers are in parentheses). Keywords
do not necessarily appear in the text of the page. They are merely associated with that section. Ex.
apples, � 1.1 (1) Terms are referenced by the page they appear on. Ex. apples, 1

F File Extensions, � 5.1(43)
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